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About this tutorial

This tutorial describes how to create reports in Infor BI Office Plus.
The tutorial is based on the Best Practices sample database. In Session 3, you are instructed to write
new values to the database.
The first part (Sessions 1-5) describes how to create, edit and convert ad-hoc reports.
The second part (Sessions 6-8) describes how to create an example of a complex, dynamic, formula
report, using MDX.
The reports which you are instructed to create in the Tutorial are reproduced in the Global Reports >
Tutorial folder of the Report Catalog. However, we recommend that, to gain most from this tutorial,
you follow the steps and try to create the reports yourself.
Reports named Session 1-1 to Session 5-3 relate to the first part of the tutorial. The reports named
TopCountAnalysis01 to TopCountAnalysis13 relate to the second part of the tutorial.
Note: Because Office Plus is an add-in to Microsoft Excel, its user interface is partly dependent on the
version of Excel which you use. This tutorial assumes that you use Microsoft Office 2010. If you use
another version, the user interface might differ significantly.

Infor Business Intelligence Office Plus for Microsoft Office Excel Tutorial | 7

About this tutorial

8 | About this tutorial

Contacting Infor

If you have questions about Infor products, go to the Infor Xtreme Support portal.
If we update this document after the product release, we will post the new version on this website. We
recommend that you check this website periodically for updated documentation.
If you have comments about Infor documentation, contact documentation@infor.com.
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Session one: Starting Office Plus and
creating an ad-hoc report

1

In this session you will learn how to log on and how to create and save Ad-hoc reports, how to change
report options, and how to exchange dimensions.

Starting Office Plus and logging on
To start Office Plus:
1 Select Start > All Programs > Infor Business Intelligence > Office Plus.
2 If prompted, enable macros.
3 Click Log On on the Office Plus ribbon.
The Log On dialog is displayed in two sections. The bottom section can be hidden.
Note: If the Log On dialog is not displayed, see the FAQ section of this session.
4 Click the Options >> button to show the full dialog.
The button label changes to Options <<.
5 Ensure that Basic is selected in the Authentication field.
6 Ensure that Admin or admin is in the User name field.
7 Ensure that the Password field is blank.
8 Select Save Password.
9 Select Best Practices Templates in the Repository field.
10 Click Connect.
11 In the Project field, ensure that Best Practices Templates is selected.
12 In the Report Catalog field, ensure that Best Practices Templates Demo for Office Plus is selected.
13 Click OK.
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FAQ
Question

Answer

I did not see the Log On dialog. Why?

A previous user logged on as the Admin user and
clicked Save Password in the Log On dialog.
To use the Log On dialog:
1 Click Log Off.
2 Click Log On With Options.
Note: These terms of the Log On dialog are explained in the glossary of the Office Plus Help
(select Help and select Glossary in the Contents
list):
• Authentication
• Repository
• Project
• Report Catalog

Creating and saving an ad-hoc report
To create and save an ad-hoc report:
1 Expand the root level of the Database Structure.
Click Database Structure in the Office Plus ribbon to display or hide the Database Structure.
2 Expand the Best Practices database alias.
The cubes of the database alias are displayed.
3 Double-click the ANALYSIS cube.
A report is created which shows the default view of the ANALYSIS cube (see Cubes in the Office
Plus help glossary). The Period and Measure dimensions form the rows and columns of the report.
The remaining dimensions of the cube are displayed at the top of the report. They are called slice
dimensions.
4 Click Save on the Office Plus ribbon.
The Save Ad-hoc Report As dialog is displayed. You can save a report as a local report or you can
share it with other users by saving it as a global report.
5 save a report as a local report or you can share it with other users by saving it as a global report.
6 Click the Local Reports folder in the Report location pane of theSave Ad-hoc Report As dialog.
By default, local reports are saved to C:\Users\Public\Documents\Infor\BI\Local Reports
.
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7 Click Create a new folder in the current location in the toolbar of the Save Ad-hoc Report As
dialog.
8 Name the folder MyTutorial.
9 Double-click the MyTutorial folder.
10 In the Report name field, specify Session 1-1.
11 Click Save to save the report and close the dialog.
12 Close the report.

FAQ
Question

Answer

No slice-dimensions are displayed. The report says There are different ways to create an ad-hoc reDrop lists here.
port, and different options to display slice- dimensions. A previous user might have selected the
option to add slice-dimensions manually. Unless
you specify a slice-dimensions option, the last-used
option is applied.
To create the ad-hoc report with the slice-dimensions:
1 Click Options on the Office Plus ribbon.
The Options dialog is displayed.
2 Click the General tab and select All dimensions from the Slice-dimensions list.
3 Double-click the ANALYSIS cube.
How do you change the location in which local re- 1 Click Extras > Options.
ports are saved?
2 Click the General tab.
3 Click the browse button next to the Local folder
field and select a location.

Specifying an ad-hoc report with options
There is another way to create an ad-hoc report in which you specify the column and row dimensions
and whether to use a template, before the report is created:
1 Click New Ad-hoc Report on the Office Plus ribbon.
The New Ad-hoc Report dialog is displayed.
2 In the Cube field, expand Best Practices and click ANALYSIS.
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3 Click Options >>.
Options for specifying the columns, rows and slice dimensions of the report are displayed.
Note: For this example, do not make any changes to the options.
4 Click OK.
The report which is created is the same as the default report.
5 Click Save and overwrite the Session 1-1 report in the MyTutorial folder.
6 Close the report.

Exchanging dimensions
When you create an ad-hoc report, you can change your view of the data by exchanging the dimensions:
1 Open the Session 1-1 report.
Either click Open in the Office Plus ribbon and browse to the report, or locate and double-click the
report in the Report Catalog pane of the Database Structure.
2 Click the Period dimension, drag it over the Measure dimension, and drop it when the Measure
dimension shows a red border.
The Period and Measure dimensions exchange positions.
3 Drag the Product slice-dimension and drop it on the Measure dimension.
The Product and Measure dimensions are exchanged.
4 Click the Product dimension, drag it outside the report, and drop it on the Database Structure pane.
'Drop lists here' is displayed in the report.
5 Drag the Product dimension from the Database Structure pane and drop it on 'Drop lists here'.
The Product dimension is added back to the report.
6 Drag the POS dimension onto the right edge of the Product dimension, and drop it when the Product
dimension has a red border at its right-hand end.
The Product and POS dimensions together form the row axis.
7 Click the arrow on the Save icon on the Office Plus ribbon and select Save as. Save the report as
Session 1-2.
The report shows values for all products, in all points of sale in all years. You can expand the Product,
POS and Period dimensions.
8 Close the report.
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FAQ
Question

Answer

How do I expand the dimensions? I do not see the A previous user might have changed the caption
plus or minus signs which I would expect.
style.
1 Click Options.
2 Click the Captions and Error Values tab and
select Caption with drill-down indicator.
Is there a difference between a drill-down and ex- Yes. If you expand an element, it and the elements
pansion?
below it are displayed. If you drill-down from an
element, the element is no longer displayed but
the elements below it are displayed.

Review
• To create an ad-hoc report, double-click a cube in the Database Structure, or use the New Ad-hoc
Report dialog, which lets you control the initial state of the report.
• To change the report, drop dimensions, and change options in the Options dialog.
• To share reports, save them in the Global Reports folder. Global Reports are saved in the Repository.
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Session two: Selecting elements

2

In the second session you will learn how to select elements.

Performing single selections
1 Open the Session 1-2 report.
The report shows the gross margin (net profit) from sales in all regions and sales channels, based
on the variance between the budgeted and actual figures. The same is true whether you look at
sales of all tires through all POS in all years, or at one type of tire sold through one POS in one year.
Note: The elements Gross Margin, All Regions, All Channels, and Variance are the default elements
of the dimensions. Default elements are specified in the database model. They are usually the same
as the root element.
2 To show the gross margin that is based on the actual sales figures, click the Variance link under
the Valtype slice dimension.
The Select Elements dialog is displayed.
3 Expand the Variance element and select Actual.
4 Click OK.
5 Click Save As.
6 Save the report as Session 2-1 in the Local Reports > MyTutorial folder.
7 Close the report.

Performing a multiple selection
By default, you can select only one element for each slice dimension. But you can combine the values
of several elements in one element with Multiple Selection.
To display values for France and Germany:
1 Open the Session 2-1 report.
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2 Click All regions to open the Select Elements dialog for the Region slice dimension.
3 Clear the All Regions check box.
4 Expand the All Regions and Europe elements.
5 Click Multiple Selection in the toolbar.
6 Select France and Germany.
Note: If the Select Elements dialog lists only one element, click Show Root Level in its toolbar.
7 Click OK.
8 Save the report as Session 2-1b in the Local Reports > Tutorial folder.

Using the List Designer
To select elements from the column and row dimensions, use the List Designer. The List Designer has
five panes: Structure Selection, Filter, Sorting, Attributes and Advanced.
Changes in the List Designer affect your reports. Changes in a report affect the selections in the List
Designer. This example demonstrates this:
1 Open the report Session 2-1b.
2 Expand All Tires to display further product elements.
3 Right-click a product element, other than the All Tires element, and select Roll-up.
Only the All Tires element is displayed.
4 Double-click the Product dimension.
The List Designer is enabled and Level: All is displayed in the bottom section of the Structure
Selection pane.
5 In the Structure Selection toolbar, select Functions > Elements underneath > All, Including
Parent.
6 In the Selection Settings pane, at the bottom of Structure Selection select Winter Tires from the
Element list.
7 Click Apply changes to the list.
Structure Selection now displays Level: All and Elements underneath Winter Tires (inclusive).
The report displays the All Tires element, and Winter Tires, its subgroups and the individual tires.
8 In Structure Selection, select Level: All and click Delete.
9 Click Apply changes to the list.
The report no longer displays the All Tires element.
10 Save the report as Session 2-2 in the Local Reports > MyTutorial folder.
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Using Structure Selection
To show the figures for Winter Tires in 2004, see "Displaying Winter Tires using drill-down" on page
19.

Displaying Winter Tires using drill-down
To display Winter Tires in 2004, its subgroups and the tires, using drill-down:
1 Open the Session 2-2 report.
2 Click the Product dimension.
The List Designer is enabled.
3 Select the Winter Tires check box.
4 In the bottom pane of Structure Selection, delete all elements except for the Winter Tires element.
5 Click Apply changes to the list.
6 Click the Period dimension.
7 In Structure Selection, delete any existing selections in the bottom pane.
8 Expand All Years and select 2004.
2004 is shown in the bottom pane.
9 Click Apply the changes to the list.
The report now displays the figures for Winter Tires in 2004. You can drill down to the product
subgroups and to the individual tires. You can also drill down to the figures for the quarters and
months of 2004.
10 Save the report as Session 2-2b.
11 Close the report.

FAQ
Question

Answer

Can I not use the List Designer for the slice dimen- Yes, you can select elements in the List Designer
sions?
instead of in the Select Elements dialog but there
is no advantage in this. In fact, it is a disadvantage,
because if you use the List Designer and select
multiple elements for a slice dimension, only the
first element is used. To apply the multiple selection, you must open the Select Element dialog,
click Multiple Selection and select the check boxes
of the elements.
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Question

Answer

What is the Whole hierarchy check box for?

If you have made changes to the list selection, you
can click Whole hierarchy to revert to the original
list without having to undo your changes. You can
then clear the check box to revert to your amended
list.

Displaying the top five values
This topic describes how to create a report to display the best selling products in each year.
To display the best-selling products:
1 Click New Ad-hoc report.
2 Expand Best Practices, and click the ANALYSIS cube.
3 Click Options >>.
4 Specify Period as the column dimension and Product as the row dimension.
5 Click OK.
The report is displayed.
6 Click the link under the Valtype slice dimension and select Actual in the Select Elements dialog.
7 Click the link under the Measure slice dimension and select Units in the Select Elements dialog.
Note: If only one dimension is displayed in the Select Elements dialog click Show Root Level.
8 In the Product dimension, right-click All Tires and select Expand All.
9 In the Period dimension, double-click All years to display the individual years.
10 Right-click a value in 2002 and select Only Show Top Values > 5.
The report displays the five elements in the Product dimension that have the highest values in 2002.
However, three of the values are consolidated values - All Tires, Summer Tires and All Season
Tires. We want to see the individual products which sold best.
11 Save the report as Session 2-3.
12 Click the Product dimension.
13 Select all entries in the pane at the bottom of Structure Selection and click Delete.
14 Click Select Level in the Structure Selection toolbar and select Size as level. Apply the changes
to the list.
The report displays the five top selling products.
Note: You can use other top values. For example, the top 10 values or the top 5% of values.
15 Save the report as Session 2-3b.
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Displaying the bottom five values
To display the five worst selling products:
1 In report Session 2-3b, right-click a value in 2002 and select Only Show Bottom Values > 5
The report shows empty cell indicators (#N/A). In all years, except 2004, the bottom five values are
empty cells. In 2004, three of the bottom five values are empty cells.
If the empty cells indicate that there were no sales, the result is correct. But no data does not
necessarily mean zero sales.
To display five values that do not include empty cells, we can suppress rows and columns that
contain only empty cells.
2 Save the report as Session 2-3c.
3 Right-click in 2002 and select Suppress Empty Rows and Columns.
The rows and columns that contain only empty cells are suppressed. Only the two values in 2004
are displayed. This is not the desired result.
To exclude the empty cells before selecting the bottom five values would produce the same result.
This is because an ad-hoc report is generated from a single MDX statement, in which the calculations
are made before the zero and empty cells are suppressed. So, even if you select empty cell
suppression before selecting the bottom five values, the report will still calculate the bottom five
values first.
4 Save the report as Session 2-3d.
5 Close the report
The solution is to use a filter to exclude the empty cells.

Applying Filters
To use a filter to exclude the empty cells:
1 Open the Session 2-3c report.
2 Right-click a value in 2002 and select Only Show Bottom Values > Show All.
3 Click the Product dimension.
4 Click the Filter pane in the List Designer.
5 Click New Filter.
The Filter Pane displays 'Caption less than'.
6 Click Caption less than.
7 Select Value from the Filter By list at the bottom of the Filter pane.
8 Select Does not equal as the condition.
9 Specify Null in the Value field and press Enter.
10 Specify the Data Area.
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Using the Data Area
When you filter or sort by value, the Data Area is enabled. The Data Area specifies to which slice of
data the filter or sort applies. Often this is the same slice of data which is displayed in the report. But
you might want to display data for one year, only where the data in a previous year met a condition.
For example, to display only the budgeted sales figures for 2004 where the actual sales in 2003 were
greater than N.
To use a filter to exclude the empty cells from the Session 2-3c report:
1 Click <Select Hierarchy> in the Hierarchy column of the Data Area.
A list is enabled.
2 Select the Period hierarchy from the list.
3 Click Current element in the Selection column.
A browse button is displayed.
4 Click the browse button.
The Select Elements dialog is displayed.
5 In the Select Elements dialog, expand All Years and double-click 2002.
6 Click OK.
7 Click Apply changes to the list.
8 In the report, right-click a value in 2002 and select Only Show Bottom Values > 5.
9 Right-click and select Suppress Empty Rows and Columns to remove the columns for 2005 and
subsequent years.
10 Save the report as report Session 2-4.
Notice that the figures for 2002 and 2003 are sorted in ascending order but the figures for 2004 are
not.

Sorting
In this example, you will filter 5 bottom counts and will sort the values only for a specified year.
1 Open the Session 2-4 report.
2 Click the Product dimension and select Sorting in the List Designer.
Notice that the Enabled check box is selected, even though we have not made any changes in the
Sorting pane. This is because the Only Show Bottom Values option creates these sorting criteria:
• Type: Value
• Cut-off Type: Bottom Count
• Cut-off Value: 5
When you filter or sort by a value, you must define the Data Area. Currently, the Data Area is defined
for 2002. We will define the Data Area for 2004.
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3 Click 2002 in the Selection column of the Data Area and click the browse button.
4 In the Select Elements dialog, delete 2002 from the right-hand pane.
5 In the Select Elements dialog, expand All Years and double-click 2004.
6 Click OK.
7 In the report, expand All Years.
The 2004 values are sorted, in ascending order, but the values for 2002 and 2003 are not.
8 Reset the report to its previous state by clearing the Enabled check boxes in the Filter and Sorting
panes and applying the changes to the list.
When you filter or sort values, the results depend on the definition of the Data Area.
Notice that the distribution of empty cells is the same in 2002 and 2003, but not in 2004.
9 Click the Product dimension and reenable the filter and the sort.
10 Right-click in 2002 and select the bottom five values. The values for 2002 and 2003 are sorted in
ascending order. To change which year is sorted:
a Right-click a value in 2002 and select Only Show Bottom Values > Show All.
b Right-click a value in another year and select Only Show Bottom Values > 5.
c Click the Product dimension and click Bottom count 5 of data area in the Sorting pane of the
List Designer.
d Click the browse button in the Selection column of the Data Area.
The Select Elements dialog is displayed.
e Delete the selected year and select a different year from the All Years element.
11 Change the selected year from 2002 to 2003 and then to 2004.
Because the distribution of empty cells in 2002 and 2003 is identical, the cells are sorted in the same
way. But the values for 2004 are not sorted in ascending order unless you select 2004 as the year
which is sorted.
12 Save the report as Session 2-5.
13 Close the report.

Review
You changed your view of the data in a report by selecting different elements from the slice dimensions
and the dimensions on the columns and rows. You used the List Designer to specify which elements
from the column and row dimensions were displayed and the order in which they were sorted.
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3

In the third session you will learn how to write back data to the database.

Writing back values to the database
In this tutorial we will write back values to the database.
1 To ensure that the cell references referred to are correct, click Options on the Infor BI Office Plus
ribbon and click the Report tab. Ensure that the Show slice-dimensions horizontally option is
selected.
If you selected Show slice-dimensions horizontally and no report is currently open, you are
prompted to save your changes as the default. Click Save as Default.
2 Click New Ad-hoc Report.
3 In the New Ad-hoc Report dialog, expand Best Practices and select the ANALYSIS cube.
4 Click Options >>.
5 Select Valtype as the column dimension.
6 Select Region as the row dimension.
7 Select Add manually from the Slice-dimensions list.
8 Click OK.
9 Click the Valtype dimension. In Structure Selection, expand Variance and select the Actual and
Budget check boxes. Apply the changes to the list.
10 Right-click All Regions in the report and select Drill-down.
11 Click Ad-hoc Report Designer on the Panes toolbar.
The Ad-hoc Report Designer is displayed. You can drag its individual panes to resize them. Ensure
that the Browser, Slice-dimensions, Rows, and Columns sections are visible.
12 Drag the Period dimension from the Ad-hoc Report Designer onto Drop lists here in the
Slice-dimensions section.
13 Drag the Measures dimension under it.
14 In the report, click the link under the Measure slice-dimension and select Units in the Select Elements
dialog.
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15 Click the link under the Period dimension and select 2004 in the Select Elements dialog.
16 In the report, double-click the Australia/Pacific element to expand it.
There are budget and actual figures for Australia and New Zealand, but there is no information for
Papua New Guinea. Note the value of the Australia/Pacific element.
We will assume that the actual sales figures for Papua New Guinea in 2004 are 32500.
17 Click the cell at the intersection of Actual and Papua New Guinea.
18 Specify 32500 and press Enter.
19 Ensure that the New Value option in the Write back dialog is selected.
20 Select Equal Distribution from the Method list.
21 Click OK.
The actual sales for Papua New Guinea are now 32500. The value of the Australia/Pacific element
increases by 32500. The values for Australia and New Zealand are unchanged.
22 Save the report as Session 3-1.

Enabling writeback
To write back values to the database, writeback must be enabled.
To enable writeback:
1 Select Start > All Programs > Infor Business Intelligence > Repository Administration.
2 Connect to the Best Practices Templates repository registration.
3 Expand Best Practices Templates > Projects > Best Practices Templates > Report Catalogs
> Best Practices Templates Demo for Office Plus > Settings.
The Settings of Report Catalog dialog is displayed.
4 Specify Enabled as the value of the writeback option.
5 In Office Plus, select create a New Formula Report.
The Splasher toolbar is enabled.
6 Click Options on the Splasher ribbon.
7 Select Enable splashing and click OK.

Specifying budget values
In this topic, we will use the actual sales figures for one year as the budget for the next year.
1 Open the Session 3-1 report.
2 Note the Actual sales for Australia/Pacific in 2004
3 Specify 2005 as the value of the Period slice dimension.
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4 Click the Budget cell for the Australia/Pacific element.
5 Specify the actual value of sales in Australia/Pacific in 2004 and press <Enter>.
The Write Back dialog is displayed.
6 Select the New Value option.
7 Select LIKE from the Method list.
8 Click <Select hierarchy> in the Hierarchy list and select Period.
9 Click the browse button in the Element list and select 2004 in the Choose Element dialog.
10 In the same way, make these assignments between the remaining hierarchies and elements:
Hierarchy

Selection

Measure

Units

POS

All POS

Product

All Tires

Region

Australia/Pacific

Channel

All Channels

Valtype

Actual

The budget figures for each region in 2005 are the same as the actual sales figures for 2004.
11 Save the report as Session 3-1b.

Increasing budget figures
In this topic, we will increase the budget by 10%.
1 Open the Session 3-1b report.
2 Select 2005 as the value of the Period slice dimension.
3 Click the budget figure for Australia/Pacific.
4 In order to open the Write Back dialog, re-enter the budget figure for Australia/Pacific and press
Enter.
The Write Back dialog is displayed.
5 Select Weighted distribution from the Method list.
6 Select the Percent option.
7 Specify 10 in the adjacent field and click OK.
The values for Australia/Pacific, Australia, New Zealand and Papua New Guinea increase by 10%.
8 Save the report as Session 3-1c.
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FAQ
Question

Answer

Why do I use All POS and All Channels? They are These are the default elements of the POS and
not part of the report.
Channel hierarchies. They are not displayed in the
report and cannot be selected, but they are part
of its structure. If you select a different element
(for example, Channel > Direct Sales) an error will
occur.

Adding charts
In this tutorial, we will add a chart to the report, between the slice-dimensions and the data table.
1 Open the Session 3-1c report.
2 Click Presentation on the Ad-hoc Report Infor BI Office Plus ribbon.
3 Select Chart and Table.
A horizontal bar chart is displayed below the slice dimensions.
The data changes when you expand, expand all, drill down and roll up elements in the data table,
or when you right-click a data series in the chart and select Expand, Collapse, Drill-down or
Roll-up. You can also double-click a data series to drill down.
You cannot expand all elements from within a chart.
4 To change the chart type, click Chart Type on the Infor BI Office Plus ribbon and select a type.
5 Click Save As and save the report as Session 3-2.
6 Close the report.

Creating Microsoft Excel charts
It can be useful in a presentation, for example, to insert an Excel chart temporarily into an ad-hoc report.
You can insert Excel formulas and charts into Ad-hoc reports, but you cannot save them. Use them
only if you do not want to save the report or if you want to save it without Excel formulas.
To insert an Excel chart:
1 Open the Session 3-2 report.
2 Click the Valtype dimension and use Structure Selection to show only the Actual figures for the
Valtype dimension.
Close the Ad-hoc Report Designer if it is displayed.
3 Click the Period slice-dimension and select 2004.
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4 Click the Region dimension and use Structure Selection to show only the children of All Regions.
5 Click Presentation on the Infor BI Office Plus ribbon and select Table, to remove the chart from
the report.
6 Drag the mouse over the data to highlight it.
7 Click the Insert tab and select Insert > Pie .
8 Select Exploded Pie as the chart subtype.
9 Close the report without saving the changes.

Review
You can write back values to the database through an ad-hoc report and some formula reports. Before
you convert an ad-hoc report to a formula report (see Session Four), consider carefully whether you
will want to write back data.
You can use some Microsoft Excel functionality (for example, charts) in an ad-hoc report but you cannot
save the report with that Excel functionality.
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4

In the fourth session you will learn how to convert Ad-hoc reports to formula reports.
Note: Before you convert an ad-hoc report to a formula report, consider carefully whether you will want
to write back data as this will affect which conversion option you select.
You can convert ad-hoc reports to formula reports or to value reports. There are two types of formula
report, which depend on the formula that is used to calculate the report. It can be an MDX.EXECUTE
formula or a CELL.GET formula.
• MDX.EXECUTE formula reports have a dynamic structure which is saved in a single formula. This
means that only one query needs to be sent to the database. You cannot write back data in an
MDX.EXECUTE formula report.
• CELL.GET formula reports have a static structure, which is saved in a number of cell.get formulas.
Each formula requires a separate database query. You can write back data in a CELL.GET report.
A values report displays the selected values in an Ad-hoc report in a Microsoft Excel spreadsheet. No
formulas are converted.
An Excel Aggregated report is similar to a cell based report but uses Excel formulas in place of
CELL.GET to calculate aggregated elements wherever possible. That means that aggregated elements
are calculated in the spreadsheet instead of being called from the server.
Reports remain connected to the cube when you convert them.

FAQ
Question

Answer

Why would I convert an ad-hoc report?

You can use some Excel functions in Ad-hoc reports. But, because they are saved as XML files,
this functionality cannot be saved. If you want to
use full Excel functionality, you must use formula
reports. You can convert an ad-hoc report to a
formula report.
Note: You can use Excel formulas and charts in
ad-hoc reports but they are not saved when you
save or close the report.
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Converting an Ad-hoc report to a formula report
In this tutorial, we will convert an ad-hoc report to a formula report which uses the CELL.GET formula.
The Global Reports > Tutorial folder contains two reports called 'Planning of Products'. One is an
Ad-hoc Report and the other is a Formula Report. The formula report uses CELL.GET to display its
values. You will convert the ad-hoc version.
1 Open the Planning of Products Adhoc report in the Global Reports > Tutorial > Session 4 folder.
2 Select Convert to Formula Report > Cell Based (CELL.GETC)
3 Click Convert to Formula Report.
The converted report is displayed.
4 Save the converted report as Session 4-1.
All the values in the report are returned by CELL.GETC formulas. CELL.GETC requires the unique
names of dimension elements and does not work with element captions.
However, captions occupy less space in a report and are more user-friendly than unique names.
For example, the captions Gross Margin, All Channels, All Regions, All POS and All Years are used
for the slice-dimensions, not the unique names.
For this reason, the unique names required by CELL.GETC are hidden, in Column C and Row 39.
5 To reveal Column C:
a Select columns B and D.
b Right-click and select Unhide.
c Increase the width of Column C to display the unique names which it contains.
6 To reveal Row 39:
a Select rows 38 and 40.
b Right-click and select Unhide.
7 Save the report.

Understanding the CELL.GETC formula
1 Open the Session 4-1 report.
2 Click the first value in the report.
The Formula Editor displays the CELL.GETC formula. The syntax of the formula is:=CELL.GETC
(Alias, Cube, Element1, Element 2, ......)
The formula is:=CELL.GETC($B$29,$B$30,D$39,$C40,$C$31,$C$32,$C$33,$C$34,$C$
35).
3 In the formula displayed in the Formula Editor, click $B$29.
The arguments of the formula, and the cells that are referenced by it, are colored to signal the parts
of the report to which the arguments belong. This can be useful in troubleshooting reports.
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The values of the Alias and Cube arguments are supplied by cells B29 and B30 respectively.
The remaining arguments of the formula are the dimension elements which comprise the cell value.
They refer to the previously hidden cells in Column C and Row 39.
Cells C40 to C68 contain the unique names of the products in the Product dimension.
Row 39 contains the unique name of each value type which is used in the report (for example,
[Valtype].[Variance].[Actual] in cell D39 and [Valtype].[Variance].[Budget] in
cell E39). The CELL.GET formula references Row 39 because it cannot use the captions displayed
in Row 38.
The CELL.GETC formula is copied to every data cell of the report. The cell references of the third
and fourth arguments are the only ones in the formula that change according to the value that is
selected in the report. Accordingly, if you click the second value in the report, cell E39 is referenced
instead of D39. And if you click the first value on the second row of the report, cell C41 is referenced
instead of C42.

Variants of CELL.GET
CELL.GETC is one of three variants of the CELL.GET formula. The other variants are:
• CELL.GETF - Formatted
• CELL.GETFC - Formatted and clustered.
The variants optimize the performance of reports.
When you group many related values in a report, the CELL.GETC formula is usually more efficient.
CELL.GETC can identify which values belong to each other and send one query to the database for
all of them. In the Planning of Products report, the values are clustered in a simple table, which is ideal
for CELL.GETC.
But, if values are scattered throughout a report, CELL.GET is better. The CELL.GET formula sends
one query to the database for each cell in the report.
CELL.GET and its variants all have the same syntax.

FAQ
Question

Answer

All ad-hoc reports seem to have clustered values. Maybe never. When you convert an ad-hoc report,
When will I use CELL.GET in an ad-hoc report? CELL.GETC is usually the best choice. But for an
ad-hoc report with a single column that contains
a large number of values, CELL.GET can be more
efficient.
The choice of the variant becomes important when
you create your own reports.
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Question

Answer
When you use CELL.GET, the time to calculate
the report is the time it takes to send one database
request for each cell. But when you use
CELL.GETC, the time to calculate the report is the
time to send one query to the database, plus the
time it takes to calculate the clusters, plus the time
to distribute the results to the table.
CELL.GET and CELL.GETC get values from the
database and apply any formatting specified on
the client computer (for example, number formats,
date formats etc.)
CELL.GETF and CELL.GETFC take formatted
values from the server and do not apply any formatting specified on the client computer. Both
variants return values as strings, which means that
you cannot perform calculations.

Understanding the MEMBER.CNAME formula
MEMBER.CNAME is used to display the captions of the slice dimensions in cells D31 to D35.
MEMBER.CNAME has these key features:
• It returns the captions of elements, not their unique names.
• If you double-click a cell containing a MEMBER.CNAME formula, the Select Element dialog is
displayed, from which you can select a different element.
Click Cell D31 and look at the Formula Editor. It contains this MEMBER.CNAME formula:
=MEMBER.CNAME($B$29,$B$30,"[POS]",$C$31)
MEMBER.CNAME has this syntax:
=MEMBER.CNAME(Alias,Cube,Dimension,Element_Choice)
In the formula in D31:
• The value of the Alias argument is supplied by Cell B29.
• The value of the Cube argument is supplied by Cell B30.
• The Dimension argument is specified in the formula.
• The Element_Choice argument is supplied by the unique name in cell C31.
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FAQ
Question

Answer

This report uses all the dimensions in the cube. The CELL.GETC formula uses the default element
What happens if I do not use all the dimensions? of any dimension for which you do not specify an
element.
To see this:
1 Select Units for the Measure slice dimension.
Units is displayed in D35.
2 Delete C35.
3 Click in the Formula Editor.
D35 reverts to Gross Margin. Gross Margin is the
default element of the Measure dimension.

Review
You used the CELL.GETC formula to convert an ad-hoc report to a formula report. The element unique
names required by CELL.GETC were hidden. The MEMBER.CNAME formula is used to display the
element captions. Captions are generally more user-friendly. Additionally, MEMBER.CNAME gives
access to the Select Element dialog, allowing users to change the slice of data displayed in the report.
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5

This tutorial describes how to use Infor BI Office Plus formulas, using MDX.EXECUTE as an example.
When you convert an ad-hoc report, one conversion option is Query Based (MDX.EXECUTE). We
recommend that you use MDX.EXECUTE reports if you do not need to write back data. They are faster
because only one query is sent to the database, and they can be dynamic. You can use Microsoft Excel
functionality to change the MDX statement and create interactive reports. MDX is to multidimensional
databases what SQL is to relational databases.
The MDX.EXECUTE formula has this syntax:

=MDX.EXECUTE (Database Alias, Full MDX Query, Columns, Rows, Data Area,
Resize Rows Automatically, Merge Labels, Indentations, Column Width,
Format Extension, Show Borders, Merge Properties, Caption Style)
The most important feature of the formula is its second argument. That is, 'Full MDX Query'. The
MDX.EXECUTE formula always remains the same. It is the MDX query that it executes that defines
the report.
To illustrate how the MDX.EXECUTE formula works, we will create a formula report with MDX.EXECUTE.
We will then convert an ad-hoc report to a Query Based (MDX.EXECUTE) report.

Creating a formula report with MDX.EXECUTE
We will build a simple Formula Report with MDX.EXCUTE in which we will use three MDX components:
SELECT, WHERE and WITH.
1 Click New Formula Report in the Office Plus ribbon.
2 Click Save and save the report as Session 5-1 in your Tutorial folder.
3 Drag the database alias from the Database Structure into cell H1.
We do this because the MDX.EXECUTE formula will refer to the database alias. In the formula, you
can specify the database alias in quotation marks (for example: "Best Practices OLAP") or you can
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specify the reference of a cell which contains the name of the database alias. It helps to prevent
errors if you drag the database alias into a cell and refer to that cell in the formula.
4 To create the SELECT part of the statement, copy this MDX statement line-by-line and paste it
vertically into cells B3 - B7.

SELECT
{[PRODUCT].[All Tires].children} on columns,
{[Period].[All Years].children} on rows
FROM
ANALYSIS
The statement says: from the Analysis cube, get the children of the All Tires (the product groups)
element and the children of the All Years element (the years) and display them in the columns and
rows of the report.
5 To execute the statement, specify this MDX statement in cell B12:=MDX.EXECUTE(H1, B3:B7,
H4,G5,H5)
The MDX statement in cells B3 to B7 is executed. It displays the columns in H4, the rows in G5 and
the data in H5.
Note: If no data is displayed, and you have specified the SELECT statement correctly, press F9 to
recalculate the report. By default, formula reports must be manually recalculated in this way. To
change the default behavior, click Options on the Extras Infor BI Office Plus ribbon. On the
Calculation tab, clear the Enable manual calculation in Excel with Office Plus starts check box.
Because the Measure dimension has not been used, the values of the report are based on the
default element, Gross Margin.
To see the values for Units instead of Gross Margin, you can add a WHERE clause to the MDX
query.
6 Paste this additional code into cell B8:

WHERE
(
[MEASURE].[Units]
)
The full statement is:

SELECT
{[PRODUCT].[All Tires].children} on columns,
{[TIME].[All Years].children} on rows
FROM
ANALYSIS
WHERE
(
[MEASURE].[Units]
)
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7 In B12 change the Query argument of the MDX.EXECUTE formula to B3:B11.
An MDX query often contains a WITH clause. It defines elements of the report which are used in
the SELECT statement.
We will define the set ProductSubGroup as [Product].[All Tires].children and use
it in the SELECT statement
8 Paste this code into cell B1:

WITH
Set ProductSubGroup AS'{[PRODUCT].[All Tires].children}'
If an error occurs, delete and reenter the apostrophe (') after AS and at the end of the line.
9 Change the SELECT statement to:

SELECT
ProductSubGroup on columns,
{[Period].[All Years].children} on rows
FROM
ANALYSIS
Now the full MDX query is:

WITH
Set ProductSubGroup AS '{[PRODUCT].[All Tires].children}'
SELECT
ProductSubGroup on columns,
{[Period].[All Years].children} on rows
FROM
ANALYSIS
WHERE
(
[MEASURE].[Units]
)
The statement occupies cells B1 to B11.
10 Change the Query argument of the MDX.EXECUTE formula to B1:B11
If you receive this error message:Syntax error: WITH Set ProductSubGroup AS'(<<<
delete and reenter the apostrophes in B2.
11 Save and close the report.
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FAQ
Question

Answer

Are the other arguments of the MDX formula not Only the first five arguments are required.
required?
How do I specify the other arguments if I want to See "Options" on page 42.
use them?

Converting an ad-hoc report with MDX.EXECUTE
1 Create an ad-hoc report with Period as the Row dimension, Valtype as the column dimension and
Product as the only slice dimension.
2 Select Summer Tires for the Product slice dimension.
3 Use Structure Selection to display only months from the Period dimension.
Click Functions and select Elements Underneath > All base elements or select Select Level >
Level 4.
4 Use Structure Selection to select these elements from the Valtype dimension:
• Actual
• Budget
5 Save the report as Session 5-2.
6 Select Convert to Formula Report > Query Based ( MDX.EXECUTE) in the Infor BI Office Plus
ribbon.
7 Click Convert to Formula Report.
8 Save the report as Session 5-3.
9 Click the link under the Product slice-dimension.
The Formula Editor displays =MEMBER.CNAME($D$29,$D$30,"[PRODUCT]","[PRODUCT].
[All Tires].[Car Tires Summer]"). This formula returns the caption Summer Tires, from
the unique name.
10 The MDX statement which defines the report is in columns A and B. Drag the left border of column
C to reveal column B and then the left border of column B to reveal column A.
11 Click the link under the Product slice-dimension and click Microsoft Excel's Formulas tab. On the
Formula Auditing Infor BI Office Plus ribbon, click Trace Dependents.
The formula reference is traced to B41 where the string forms part of the WHERE clause of the
SELECT statement.
The MDX.EXECUTE formula which executes the MDX statement is in cell B45.
12 Click cell B45.
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The MDX formula is displayed in the Formula Editor.

=MDX.EXECUTE($D$29,$B$28:$B$44,$E$33,$D$34,$E$34,TRUE,TRUE,2,15,0,
FALSE,TRUE,1)
The syntax of the MDX formula is:

=MDX.EXECUTE (Alias, Query, Columns, Rows, Dataset, Auto
Resize Row, Merge Labels, Indentation, Column Width, Format
Extension, Show Borders, Merge Properties, Caption Style)
• Alias - cell D29 contains the database alias.
• Query - cells B28 to B44 contain the MDX query executed by the formula.
• Columns - cell E33 contains the first dimension cell of the column.
• Rows - cell D34 contains the first dimension cell of the row.
• Dataset - cell E34 is the first data area cell on the worksheet.
• Auto Resize Row - is TRUE (turned on).
• Merge Labels is turned on.
• Indentation is 2.
• Column width is 15.
• Format extension is 0.
• Show borders is turned off.
• Merge properties is turned on.
• Caption style is 1.
13 Click Remove Arrows.
14 Click the Infor BI Office Plus tab.
15 Save the report.

FAQ
Question

Answer

Where and how do I specify these arguments?

See "Options" on page 42

Options
Open Session 5-2 (the ad-hoc version of the report).
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Click Options on the Extras Infor BI Office Plus ribbon. The options on the Ad-hoc Report tab and
Captions and Error Values tabs affect the arguments of the MDX.EXECUTE formula when a report
is converted.
On the Ad-hoc Report tab, the Resize row captions automatically check box is selected, which sets
the Auto Resize Row argument to TRUE.
The Merge labels check box is selected, which sets the Merge Labels argument to TRUE.
The value in the Indent field is 2, which sets the Indentation argument to 2. This argument specifies
the indentation of the list elements underneath their column heading. Zero means no indentation. Nine
is the maximum indentation.
The Column width check box is selected. The Column Width argument is set to 15.
The argument Format Extension has no equivalent in the Options dialog. It can be set to 0, 1, or 2. If
numbers on the database are formatted, 0 returns the numbers with that formatting, 2 returns the
numbers without the database formatting. You can apply formatting on the client computer.
When the argument is 1, numbers are returned as strings. The format defined in the database is used.
The Show borders check box is not selected, which sets the Show Borders argument to FALSE.
Specify TRUE to display a border around the elements of the column dimension and the elements of
the row dimension.
The Merge Properties argument of the formula is obsolete.
On the Captions and Error Values tab, Caption with drill-down indicator is selected in the Caption
style list, which sets the Caption Style argument to 1. The second option in the list (Caption) sets the
argument to 2, etc.
When you write or edit MDX you can use 1 and 0 instead of TRUE and FALSE.

FAQ
Question

Answer

Only the first five arguments of the formula are
necessary. But, if I want to use some of the optional arguments, do I also have to specify the remaining arguments?

If you convert an ad-hoc report, all arguments must
be specified. If you write or edit the MDX.EXECUTE formula, you can use blank spaces, enclosed by commas, for the arguments you do not
want to use:

=MDX.EXECUTE($D$29,$B$28:$B$46,$E$33,$D$34,$E$34,,TRUE,,,0,FALSE,TRUE,1)
To see the effects, experiment with changing the
arguments of the MDX.EXECUTE formula.
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Review
You have created a report with MDX and the MDX.EXECUTE formula and edited the MDX and the
arguments of the formula to make changes to the report.
The second half of this tutorial describes how to create an example of a complex, dynamic formula
report with MDX. If you are experienced with MDX, it may emphasize the potential of MDX.EXECUTE
formula reports. If you are a beginner, it can form the basis for further self study.
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6

In this part of the tutorial, we will create a complex formula report with MDX.EXECUTE. If you are
familiar with MDX, this shows you the potential of formula reports in Office Plus.
If you are new to MDX, it provides the basis of further study.
There is some preparatory work before we start writing MDX. In this session, you add combo boxes
and labels to the report layout and use named cells to create building blocks to be used in the MDX
statement.
You might find it easiest to copy and paste sections of MDX from this document into the report. If you
do so, ensure that you always delete and reenter any quotation marks (“) and apostrophes ('). Also be
aware that, if you copy a code sample which occupies multiple lines in this document and paste it into
a single cell, the cell will accept only the first line of code. Instead, copy and paste each line individually,
taking care to maintain the syntax of the code.
We will create a formula report and name it Top Count Analysis.
• It will show the top and bottom 5, 10, 25 or 50 products in the Best Practices Templates database.
• It will have three combo boxes, from which you select a measure (for example. 'units sold'), a level
(for example. 'Product Group'), and the number of 'top' and 'bottom' products to be displayed.
• It will also have fields for the selection of sales channel, region, and year. The column headings will
change according to the selected measure, level and count.
• The report will be produced by an MDX statement and be executed by an MDX.EXECUTE formula.
• We will specify the MDX statement and other components of the report in columns B and C. To help
others understand the report, we will specify descriptions in column A.

Defining the report layout
To define the report layout:
1 Click New Formula Report in the Infor BI Office Plus ribbon.
2 Save the report as Top Count Analysis01 in your Tutorial folder.
3 Specify Measure: in E4.
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4 Specify Count: in E6.
5 Specify Level: in E8.
6 Specify Select Channel: in E10.
7 Specify Select Region: in E12.
8 Specify Select Year: in E14.
9 Save the report.

Creating combo boxes
To create combo boxes:
1 Enable the Developer tab in Microsoft Excel. To do this:
a Click the Microsoft File tab, and then click Options.
b Click Customize Ribbon.
The Customize the Ribbon pane is displayed.
c Select Main Tabs from the Customize the Ribbon list.
d Check the Developer check box.
e Click OK.
The Developer tab is added to the Ribbon.
Note: These steps relate to Microsoft Office 2010. The procedure to enable the Developer tab
differs in other versions of Microsoft Office.
2 Click the Developer tab.
3 Click Insert on the Controls toolbar and click the Combo Box form control icon.
The cursor changes to a +.
4 Draw a combo box in cells F4 to G4.
5 Draw a combo box in cells F6 to G6
6 Draw a combo box in cells F8 to G8.
7 Save the report as TopCountAnalysis02.

Filling combo boxes
To populate each combo box, we will list its items in a range of cells and then specify that range in the
properties of the combo box.
To list the available measures in the combo box:
1 Open TopCountAnalysis02 and save it as TopCountAnalysis03.
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2 In TopCountAnalysis03, specify Measures in A123.
3 Specify Gross Margin in B123.
4 Specify Net Revenue in B124.
5 Specify Revenue in B125.
6 Specify Discounts in B126.
7 Specify SD in B127.
8 Specify Cost of Sales in B128.
9 Specify Production Costs in B129.
10 Specify Price in B130.
11 Specify Units in B131.
12 To populate the Measure combo box, right-click it and select Format Control.
13 In the Input Range field, specify B123:B131.
14 Click OK.
The Measure combo box now contains the list of measures specified in cells B123 to B131.
15 Specify Counts in cell A132.
16 In cells B132 to B135, specify 5,10,25 and 50 respectively.
17 Populate the Count combo box with the range B132:B135.
18 Specify Levels in cell A136.
19 In cells B136 to B139, specify All, Product Group, Tire, and Size respectively.
20 Populate the Level combo box with the range B136:B139.
21 Save the report.
There are now three combo boxes, filled with elements. The formulas in the report must be dynamic.
That is, they must change according to the element that is selected in each combo box.

Naming cells
In this topic, we will assign names to the cells which will contain the output of the combo boxes in the
report. Note that the names cannot contain spaces.
To name cells:
1 Open TopCountAnalysis03 and save it as TopCountAnalysis04.
2 In TopCountAnalysis04, specify Outputs in cell A140.
3 Click cell B140.
4 In the Name Box field at the left of the Formula Editor, the cell reference of the active cell, B140 is
displayed. Overwrite B140 with MeasureOutput and press Enter.
Note: To edit names, click Microsoft Excel's Formula tab and then click Name Manager.
5 Name cell B141 CountOutput.
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6 Name B142 LevelOutput.
7 Name B143 MeasureOffset.
8 Name B144, CountOffset.
9 Name B145, LevelOffset.
10 Save the report.

Linking cells
We will now populate the named cells, MeasureOutput, CountOutput and LevelOutput, by linking them
to the combo boxes.
To link the combo boxes to the named cells:
1 Open TopCountAnalysis04 and save it as TopCountAnalysis05.
2 In TopCountAnalysis05, right-click the Measure combo box and select Format Control.
3 Specify MeasureOutput in the Cell link field.
4 Specify CountOutput in the Cell link field of the Count combo box.
5 Specify LevelOutput in the Cell link field of the Level combo box.
6 Save the report.
The named cells, B140, B141 and B142 display values which represent the positions of the items
currently selected in the combo boxes. For example, if you select Gross Margin in the Measure combo
box, 50 in the Count combo box and Product Group in the Level combo box, the named cells display
1, 4 and 2 respectively.

Converting the outputs
The combo boxes output numerical values to cells B140, B141 and B142. The values represent the
items currently selected in the combo boxes. But we will need the captions of the items. We will use
the Offset function to get the captions.
To use the Offset function:
1 Open TopCountAnalysis05 and save it as TopCountAnalysis06.
2 In TopCountAnalysis06, specify Offsets in cell A143 .
3 In cell B143, specify =Offset(B122, MeasureOutput,0)
4 In cell B144, specify =Offset(B131, CountOutput,0)
5 In cell B145, specify =Offset(B135, LevelOutput, 0)
6 Save the report.
Cells B143, B144 and B145 display the captions of the items selected in the combo boxes. The content
of the cells changes as you select different items in the combo boxes.
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Review
You have used combo boxes and labels to define the visible elements of the report. You have connected
the combo boxes to named cells to output index numbers for the items selected. You then used the
Offset function to derive the item captions from the index numbers.
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7

Concatenating cells
The elements which you select in the Measure, Count and Level combo boxes will affect the headings
in the report. For example, if you specify Net Revenue and Tire with a count of 5, the headings in the
report will display Top 5-Tire Net Revenue.
To display the selected count and level, we will concatenate the named cells which hold this information
(i.e. B143, B144 and B145) with the strings "Top" and "-":
1 Open TopCountAnalysis06 and save it as TopCountAnalysis07.
2 In cell E18 of TopCountAnalysis07, specify ="Top "&CountOffset&" - "&LevelOffset
Note: If you copy and paste this string but an error occurs, delete and reenter the quotation marks
(").
3 Check that the heading in E18 changes when you select from the Count and Level combo boxes.
4 To show the bottom count in cell H18: copy E18 into H18, and replace ="Top" with ="Bottom"
5 To display the selected measure, specify =MeasureOffset in F18 and I18.
The Measure combo box is linked to the named cell MeasureOutput (cell B140) and the measure
in F18 changes as you select different measures from the Measure combo box.
6 Save the report.

Displaying Captions
We will use the MEMBER.CNAME formula to select the sales channel, region and year. When you
double-click a caption which is returned by MEMBER.CNAME, the Select Elements dialog is displayed.
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You learned in Session 4 that you can use MEMBER.CNAME when you have the unique name of an
element and want to display its caption. This formula displays Europe:

=MEMBER.CNAME(“Best Practices OLAP”,"Analysis”,”[Region]”,
”[Region].[All Regions].[Europe]”)
1 Open TopCountAnalysis07 and save it as TopCountAnalysis08.
2 In TopCountAnalysis08, name cell B76 Alias.
3 In the Database Structure pane, expand the root level and drag the database alias (for example,
Best Practices OLAP) into B76.
4 Name cell B68 Cube and specify Analysis in the cell.
5 In cell C10, specify [Channel].
6 In cell C12, specify [Region].
7 In cell C14, enter [Period].
8 In F10 specify=MEMBER.CNAME(Alias,Cube,C10,"[Channel].[All Channels]")
F10 displays 'All Channels'.
Note: If you copy and paste the string and F10 does not display 'All Channels', delete and reenter
the quotation marks (").
9 Use MEMBER.CNAME to display All Regions ([Region].[All Regions]") in cell F12 and All Years
([Period].[All Years]) in F14.
When you double-click All Channels, All Regions or All Years, the Select Element dialog is displayed.
10 Save the report.

Displaying Unique Names
The MDX statement will display the top count of elements from the ANALYSIS cube, according to the
channel, region and year selected in cells F10, F12 and F14.
Like CELL.GETC, MDX.EXECUTE requires element unique names. But we have displayed the element
captions in cells F10, F12 and F14.
We will use KEY.GET to display the unique names and display them in column G.
1 Open TopCountAnalysis08 and save it as TopCountAnalysis09.
2 In TopCountAnalysis09, specify =KEY.GET(F10) in cell G10.
Cell G10 displays [Channel].[All Channels].
3 Use KEY.GET to display the unique names of the Region and Period elements in G12 and G14.
4 Save the report.
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Review
In this session you have used MEMBER.CNAME to display captions. You have used KEY.GET to
provide the unique names that are required by the MDX statement.
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8

As we saw in session five, MDX queries often contain a WITH clause that precedes the SELECT
statement. The WITH clause defines elements that are used in the SELECT statement.
We will use the WITH clause to define a set called TOP_MEMBERS. When we define the SELECT
statement in session nine, we will select TOP_MEMBERS.
We must define TOP_MEMBERS so that, for any selected measure and level:
• It excludes empty cells
• It orders them in descending order
• It calculates the top N elements
In this session you will learn how to create statements which meet each of these requirements and
then how to combine them into a single statement.

Excluding empty cells
To exclude empty cells, we will use the Filter function.
Because you can select measures and levels from the Measure and Level combo boxes, the filter must
be dynamic. There is already a dynamic link to the Measure combo box. It is the named cell
MeasureOutput (B140), which changes according to the measure which you select in the combo box.
But MeasureOutput contains a numerical value. And MeasureOffset (B143) contains the caption, which
we derived from MeasureOutput.
But you cannot use either MeasureOutput or MeasureOffset in the statement because the unique name
of the selected measure is required. The same issue applies to LevelOutput and LevelOffset.
We can create the unique names we require by combining [Measure] with the caption in B143 and
[Product] with the caption in B145.
1 Open TopCountAnalysis09 and save it as TopCountAnalysis10.
2 In TopCountAnalysis10, name cell B122 Measure and specify [Measure] in the cell.
3 Specify Unique Names in A146.
4 In cell B146, specify =Measure&".["&MeasureOffset&"]"
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If you copy and paste into B146, delete and reenter the quotation marks ("). Cell B146 now displays
the unique name of the measure which is selected in the Measure combo box.
5 Name B146 MeasureUnique.
6 Name cell B121 Level and specify [Product] in the cell.
7 In cell B147, specify =Level&".["&LevelOffset&"]"
Cell B147 displays the unique name of the product level which is selected in the Level combo box.
8 Name B147 ProductUnique.
9 Save the report.

Filtering the level and measure
Now filter the level and the measure. The named cell LevelOffset (B145) contains the caption of the
element which you selected in the Level combo box. But the unique name is required.
This is the code we will use for the filter part of the WITH clause:

=" SET TOP_MEMBERS AS '{FILTER("&ProductUnique&".MEMBERS,IsEmpty
("&Measure&")=0)}'"
The MDX Filter function returns a set based on a search criterion. Here you filter the elements of the
selected level by searching for empty strings in the selected measure.

Ordering the results
The Order function arranges the elements of a set. This statement will order the elements of the selected
level (cell B147) and measure (cell B146) in descending order.

=" SET TOP_MEMBERS AS '{ORDER("&ProductUnique&".MEMBERS,
"&MeasureUnique&",BDESC)}'"
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Calculating the Top elements
The Topcount function calculates the highest values and returns the number of elements specified in
the CountOffset cell (B144).

="SET TOP_MEMBERS AS '{TOPCOUNT("&ProductUnique&".members,"
&CountOffset&","&MeasureUnique&")}'"

Combining the statements
We need a single statement which combines all three SET statements.
This statement defines the TOP_MEMBERS set. It filters out empty cells, orders the elements in
descending order and calculates the top N elements:

=" SET TOP_MEMBERS AS '{ORDER(TOPCOUNT(FILTER("&ProductUnique&".
MEMBERS,
IsEmpty("&MeasureUnique&")=0),"&CountOffset&","&MeasureUnique&"),
"&MeasureUnique&",BDESC)}'"
1 Open TopCountAnalysis10 and save it as TopCountAnalysis11.
2 In TopCountAnalysis11, insert the TopMembers statement in cell B80.
Note: If you copy and paste the statement, delete and reenter the quotation marks (") and
apostrophes (').
In the SELECT statement, we will select TOP_MEMBERS in the rows.
In the complete MDX statement, TOP_MEMBERS will be referred to three times. Ensure that you
use the same case each time you refer to TOP_MEMBERS. Errors will occur if, for example, you
refer to TOP_MEMBERS in one place but to Top_Members in others.
3 Save the report.

Labeling the results
The statement in cell B80 orders the results but does not number them. It would be useful to label each
result from 1 to 5, 1 to 10, etc., depending on the number of results selected.
We will define a member to select in the SELECT statement, which includes a number as part of its
definition.
We will call the member [Measure].Label. In the SELECT statement, we will select it in the columns.
To display the results without a label:
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1 Open TopCountAnalysis11 and save it as TopCountAnalysis12.
2 Define [Measure].Label as:="MEMBER "&Measure&".LABEL AS ' "&Level&".CURRENTMEMBER.
NAME'"
This statement defines [Measure].Label as the current element of the Product dimension.
Measure is the named cell B122 which contains [Measure].
Level is the named cell B121 which contains [Product].
To label each result with a number, followed by a period, we rank the members of TOP_MEMBERS
and use CSTR to return the ranking as a number:=”MEMBER “&Measure&”.LABEL AS ‘CSTR
(RANK(“&Level&”.CURRENTMEMBER.TOP_MEMBERS))’
To display a period after the number, add +””.”
The complete definition of [Measure].Label is:

=" MEMBER "&Measure&".[LABEL] AS
'CSTR(RANK("&Level&".CURRENTMEMBER,TOP_MEMBERS)) +"".
""+ "&Level&".CURRENTMEMBER.NAME',SOLVE_ORDER=1"
3 Specify the definition in cell B81.
If you copy and paste the definition but an error occurs, delete and reenter the quotation marks (")
and apostrophes(').
4 Save the report.

Filling the report with data
We can now write the MDX statement and MDX.EXECUTE formula to fill the report with data.
In the previous session we defined the elements to be used in the columns and rows of the report, i.e.
TOP_MEMBERS and [Measure].Label. The elements require specific characteristics, which you defined
with MDX. Now include these definitions in the WITH clause of the MDX SELECT statement.
The MDX statement selects TOP_MEMBERS in the rows and [Measure].Label in the columns, where
channel, region and time are selected in cell F10, F12 and F14 of the report.
1 In cell B79, specify WITH.
2 In cell B82, specify SELECT
3 In B83, specify ="{"&Measure&".Label,"&MeasureUnique&"}"
4 In B84, specify on columns,
5 In cell B85, specify TOP_MEMBERS
6 In cell B86, specify on rows
7 In cell B87, specify from
8 In cell B88, specify ANALYSIS.
9 In cell B89 specify WHERE
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10 In cell B90, specify (
Cell B85 combines [Measure].Label with the selected measure, located in named cell B143, which
changes according to the selected measure in the Measure combo box.
11 Now specify the WHERE clause of the statement. The statement selects TOP_MEMBERS and
[Member].Label, where channel, region and time are selected in F10, F12 and F14.
The unique names of the selected elements of the Channel, Regions, and Period dimensions are
specified in cells G10, G12, and G14.
12 In cell B91, specify =$G$10&","
13 In cell B92, specify =$G$12&","
14 In cell B93, specify =$G$14
[Period].[All Years] is displayed. The syntax of the SELECT statement does not require a comma
at the end of the WHERE clause.
15 In cell B94, specify ).
The SELECT statement for the top count analysis is complete.
16 Save the report.

Displaying the bottom count
Use the same select statement to display the lowest N figures in the report:
1 Copy the MDX statement (cells B79 to B94) into cell B96.
The statement occupies B96 to B111.
2 In cell B97 change .....AS '{ORDER(TOPCOUNT(FILTER... to AS
'{ORDER(BOTTOMCOUNT(FILTER...
3 Save the report.

Executing the MDX Statement
There are two SELECT statements in the report. Two MDX.EXECUTE formulas are required to execute
them.
This is the syntax:

=MDX.EXECUTE (Alias, Query, Columns, Rows, Dataset, Auto
Resize Row, Merge Labels, Indentations, Column Width, Format
Extension,Show Borders, Merge Properties, Caption Style)
1 Open TopCountAnalysis12 and save it as TopCountAnalysis13.
2 In cell B95 of TopCountAnalysis13, specify: =MDX.EXECUTE(Alias,B79:B94,,,E19,,,,,,,)
Here, Alias refers to the named cell B76 which contains Best Practices OLAP.
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B79:B94 is the range of cells in which you wrote the SELECT statement.
Do not specify the columns or the rows because the content of cells B83 and B85 is not to be
displayed in the report.
E19 is the first data cell of the report.
3 Create the same formula in cell B112, but change the range of the query to B96:B111.
4 Change the Dataset argument from E19 to H19.
5 Press F9 to recalculate the formula.
The MDX statement and MDX.EXECUTE formula are complete, and the report displays data
according to the selections in the report.
6 Save the report.

Formatting reports
All that remains is to format the report to improve its appearance. This is outside the scope of this
tutorial but you would, for example, hide columns A, B, C and G and increase the width of columns E
and F.

Review
The MDX SELECT statement which fills the report with data is simple, because of the preparatory work
of the previous sessions. You have used named cells to make the selection in the report available to
the MDX statement. You have used those named cells in the definition of the elements that will form
the columns and rows of the report.
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